
 
 
 
 
 
 
 

The Effect of Web Usability on Users’ Web 
Experience 
 
 
BY Molly Herring 
 
 
 
 
 
 
 
 
 
 
 
ADVISOR • Janet Prichard 
 
 
 
_________________________________________________________________________________________ 
 
Submitted in partial fulfillment of the requirements for graduation  
with honors in the Bryant University Honors Program 
April 2012 



Table of Contents 
Abstract ............................................................................................................................................3
Introduction ......................................................................................................................................4

Contribution .................................................................................................................................4
Literature Review.............................................................................................................................5
Methodology ....................................................................................................................................8

Guidelines ....................................................................................................................................9
Heuristic Evaluation .....................................................................................................................9
Usability Testing ........................................................................................................................10
Usability Survey .........................................................................................................................11

Results ............................................................................................................................................11
Usability Study...........................................................................................................................11
Usability Survey .........................................................................................................................13

Analysis of Results ........................................................................................................................18
Conclusion .....................................................................................................................................21
Appendices .....................................................................................................................................22

Appendix A – HHS Strength of Evidence Scale .......................................................................23
Appendix B – Preliminary List of Guidelines ...........................................................................24
Appendix C – Chosen Guidelines ..............................................................................................24
Appendix D – Heuristic Evaluation ...........................................................................................26
Appendix E – Usability Session Outline ...................................................................................29
Appendix F – Usability Survey..................................................................................................30

Bibliography ..................................................................................................................................31



The Effect of Web Usability on Users’ Web Experience 
Senior Capstone Project for Molly Herring 

- 3 - 

ABSTRACT 
The ease with which a website visitor can find what they need is positively correlated with 

visitor satisfaction(Institute for Dynamic Educational Advancement, 2008).  Web usability is a 

field that studies what factors affect the visitor’s ability to navigate through a website.  Although 

there are publications outlining specific usability guidelines, many of them have little or no 

academic research to support the claim.  HHS developed a list of 209 guidelines and rated each 

according to their strength of evidence (research-based support, 5 – high, 1 – low).  Using 

heuristic evaluation and usability testing, this study provides additional research-based 

knowledge for those guidelines rated with a low strength of evidence.  Results indicate that users 

desire printer-friendly webpages, require feedback on their location within the website, find 

linking to related content helpful, and expect a search option to be provided on every page.  

Additional research is necessary to determine if providing descriptive page titles or labeling 

pushbuttons clearly is important to web usability.   
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INTRODUCTION 

As the internet continues to expand exponentially, there are those who believe specific standards 

are necessary to provide valid and valuable information in a guest-friendly manner.  This is the 

field of web usability, whose main goal is to design and develop websites easy to understand and 

intuitively navigable.  Web usability is an entirely outward facing, user-driven experience and 

forces companies and website owners to completely understand the goals, needs, and mindset of 

their visitors.  Companies are beginning to understand that to ensure customer loyalty and return, 

they must cater their sites to their users’ needs, as well as making sure they portray all the 

necessary information.  As with many disciplines, the company must understand that their target 

audience does not have the same understanding of their services and needs to be convinced 

during the first impression – often within the first 10 seconds of visiting the page – that this 

website has the information they are seeking.  Creating a bad first impression online can be more 

damaging than in person as it is more difficult to reach out to the customer; rather, they must 

accomplish the more difficult task of drawing the audience member to them.   

 

Web usability is a relatively new field but has found stalwart support  in numerous locations, 

including Jakob Nielsen, Ph.D., the International Standard of Organization (through the ISO 

9241-151:2008 standard) and the Department of Health and Human Services (HHS).  HHS 

conducted a study on what website features contributed to a visitor’s ease of use when navigating 

through a website.  These features became guidelines for the design of all sites within their 

Health and Human Services network.  In addition to publishing the list of guidelines, they also 

rated each according to its relative importance (RI) and strength of evidence (SE).  RI is scored 

1-5 where 1 is of little importance to usable web design and a 5 is of most importance.  SE is 

scored according to the amount of research performed in support of the guideline’s inclusion on 

the list.  HHS explicitly states that a low SE score is meant to encourage other researchers to 

perform their own studies to contribute to the body of knowledge. 

Contribution 
I will contribute to the web usability field by running a study using HHS guidelines that have a 

relative importance of 4 or 5 and strength of evidence rating of 1 or 2.  This combination of 

scales results in those guidelines rated highly important to web usability but have little or no 
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academic research and evidence to support that claim.  This will benefit the knowledgebase by 

providing further evidence for or against the inclusion of the guidelines in the HHS’s 

publication.  My work is similar to other studies (ISO 9241-151:2008) in that I am testing the 

usability of web elements.  However, my work differs as each guideline I am focusing on has not 

yet been studied conclusively.  I hypothesize that my results will support the original decision to 

include these guidelines in the HHS publication. 

LITERATURE REVIEW 
Jakob Nielsen introduces the inherent conflict and purpose behind the field of web usability.  It is 

often a debate between art and engineering, where the developer must balance the desire to 

create an aesthetically pleasing site while also ensuring a visitor’s needs are easily met.  A 

website must not only visually attract the user but also provide enough utility that they are able 

to complete their intended tasks.  As evident with his personal website, http://useit.com, Nielsen 

greatly prefers ensuring utility over providing frivolous design for the purpose of appearance 

only.  Furthermore, he notes that web usability changes less rapidly than web technology, 

transforming this into a discussion of psychology and behavior versus technology evolution.  As 

he states: 

“In product design and software design, customers pay first and experience usability 

later.  On the Web, users experience usability first and pay later.  Very clear why 

usability is more important than web design.” (Nielsen, Designing Web Usability, 1999) 

 

Web Development: A Visual-Spacial Approach by Craig M. Baehr(2007) discusses the 

importance of usability in the effective design and development of a website.  Because the 

development process is iterative (a version is delivered, tested, feedback is given and changes are 

made) the testing process is repeated numerous times before the official release.  Therefore, 

usability testing needs to occur not only once, but be integrated throughout the entire process.  

Baehr presents three different processes for testing that target different aspects of the site.  

Technical usability testing assesses the website’s functionality across a variety of platforms and 

browsers.  A usability worksheet can aid in organizing data and provide side-by-side 

comparisons of a site’s output on different platforms.  Visual-spatial usability testing focuses on 

http://useit.com/
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how the user traverses the site, assuring that one can navigate through easily.  Testing can be 

task-based – asking the user to perform a specific task and see how they do so – and evaluation-

based where the tester examines the usefulness and flexibility of the tool.  The third test assesses 

accessibility measures, ensuring that the site can reach the largest audience possible, including 

those with disabilities.  For all of these measures, the same process can be followed: 1) establish 

goals, 2) develop testing instruments, 3) conduct the test, and 4) analyze the results. 

 

The Health and Human Services guidelines are continually assessed and revised to “enable 

organizations to make more effective design decisions” (U.S. Department of Health and Human 

Services, 2006, p. xvi).  Originally developed for the effective dissemination of information on 

Health and Human Services websites, the guidelines are useful for improving usability on all 

sites.  There are currently 209 guidelines that, by the author’s suggestion, can be used in 

numerous ways: a designer may follow the guidelines while creating a webpage, usability 

specialists can create a checklist when reviewing a site, or researchers can determine which 

guidelines require additional evidence and perform studies to acquire more.  The guidelines have 

also been rated according to level of importance and strength of evidence.  Level of importance 

describes which guidelines will aid in usability the most and should be first considered while 

designing a website.  Strength of evidence relates to the amount of research performed about a 

particular guideline.  Both research and expert opinion were considered during the development 

of the guidelines, but low strength of evidence is meant to encourage further research.  Please see 

Appendix A for an explanation of the strength of evidence scale.  HHS does not provide an 

explicit definition for relative importance beyond except that a “5” is the most important element 

to consider including and “1” is the least. 

 

HHS first began researching usability elements in 2004, compiling various guidelines from 

numerous different sources, including informal web usability websites, peer-reviewed research, 

and in-house standards and studies.  The list totaled 500 originally but was reduced to 398 after 

the team took a first pass and combined or removed contradictory guidelines.  Relative 

importance was decided among a group of 16 external reviewers consisting of eight web 

designers and eight usability experts.  Guidelines that were determined to have little or no impact 
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on the success of a site were removed, shrinking the list to 287.  Eight usability researchers, 

practitioners and authors, all published and experienced in the field, created their own set of 

criteria for determining the strength of evidence for each guideline.  More guidelines were 

removed as designers located graphical examples to be used in the published version.  Twenty 

web designers partook in a card-sorting exercise to place guidelines into chapters and name them 

appropriately.  These categories were then tested for usability.  The final 2004 version had 187 

guidelines; updates and revisions are made upon evaluating new research.  The 2006 version 

updated 21 guidelines and added 22 more and the relative importance was revised based on a 

survey of 36 web professionals.  These were edited by three independent groups of web 

professionals before publication. 

 

ISO 9241-151, “Ergonomics of human-system interaction – Guidance on World Wide Web user 

interfaces,” became an international standard in 2008 and promotes making websites “accessible 

to the widest possible range of users” (p. vi).  While this includes those with disabilities, the 

standard does not specifically discuss or target factors unique to that audience.  While the 

entirety of ISO-9241 discusses usability of various agents, Part 151 focuses on the presentation 

of web content and a user’s ability to navigate through a website.  The World Wide Web creates 

unique usability issues because public websites are viewable by a wide range of audiences 

resulting in a variety of user capabilities, knowledge, and goals.  Furthermore, there are 

numerous ways to access the internet, including multiple browsers and mobile agents that render 

pages differently.  These guidelines can be applied to the internet, intranets, and extranets, but 

should not be applied indiscriminately to mobile devices.  Similar to the HHS guidelines, this 

standard’s target audience includes web professionals, developers, content providers, usability 

experts and other users who are impacted by or interested in web usability.  As such, the standard 

provides a sample procedure and checklist for assessing a website’s usability. 

 

Not only are various usability guidelines occasionally contradictory with each other, but they 

may contradict other web standards.  Visser and Weideman explore this idea in “An empirical 

study on website usability elements and how they affect search engine optimization,” targeting 

web elements that play a role in both usability and search engine optimization (SEO).  Both 
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concepts are important to consider when designing and developing a website, but they target two 

different audiences: the former process aids search engine spiders in locating and indexing 

websites while the latter instead targets a human audience, whose goals upon visiting the site are 

often many and varied.  For example, a search engine spider does not consider the aesthetic value 

of the page, while the human user may be more attracted to those sites that contain professional 

graphics and evocative imagery and colors.  The authors note that research suggests adding a 

page for a site’s privacy policy, about us, and testimonials to increase the credibility of the site 

and encourage the user’s trust.  However, these pages do not directly relate to the topic of the 

website and therefore are considered extraneous to SEO. 

 

Visser and Weideman chose four website attributes that were a source of contradiction between 

usability and SEO: trust and credibility, single page view and content, keywords, and use of 

images.  A control site was created by a web designer with little knowledge of usability and SEO 

guidelines and an experimental site was developed according to usability attributes, without any 

consideration for SEO.  The study measured the level of traffic each site received, how many 

pages each visitor viewed, and how many visitors actually purchased the product that was being 

sold.  From the results, Visser and Weidemann concluded that “usability is a prerequisite for 

effective website design” (p. 1) because a higher percentage of visitors to the experimental site 

submitted a contact form (‘conversions’) than the control site.  Further research would include a 

second experimental website that focuses on SEO elements and ignores usability guidelines. 

METHODOLOGY 
Using the standards published by HHS, I created a preliminary list of all guidelines rated by 

HHS with a “1” or “2” in their strength of evidence (SE) scale that were also rated “4” or “5” in 

their relative importance (RI) scale.I chose 6 specific guidelines to test in an effort to provide 

additional strength of evidence.  The traditional usability testing methods work with a developed 

site or site currently in development and test whether or not the site meets a set of heuristics and 

needs of the users.  For this study, I am instead testing a set of standards used to develop a usable 

website.  I have chosen travel industry websites Travelocity.com and Expedia.com to use for a 

heuristic evaluation, which will locate how the sites operate in accordance with the 6 guidelines I 
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have chosen to test.  Usability testing with human subjects will then determine how much effect 

these guidelines play on the usability of the website and how important the user rates the 

standards.   

Guidelines 
There are 60 guidelines that were given a 1 or 2 rating on the SE scale (please see Appendix B 

for this list).  Of these, five had a 5 RI rating.  Twenty-one guidelines were rated a 4 and the 

remaining 34 scored 3 or below.  I have chosen 6 guidelines that can readily be tested by 

currently existing websites, without the need for developing an experimental website.  Below are 

the six chosen guidelines, as well as a summary of HHS’s current findings: 

- Develop Pages that Will Print Properly: a website should be able to print onto the 

standard 8.5 x 11” piece of paper without cutting off any of the content. 

- Provide Feedback on User’s Locations: provide visual cues as to where the user currently 

is in the hierarchy of the website.  This may include breadcrumb navigation or colored 

tab structure. 

- Provide Descriptive Page Titles: search engines use page titles to index sites so using 

descriptive, clear titles will help the user determine if this is a useful website to visit. 

- Link to Related Content: the related content may be useful to the user. 

- Label Pushbuttons Clearly: a user should know exactly what will happen when they click 

on a pushbutton. 

- Provide a Search Option on Each Page: while a site’s search engine shouldn’t be relied 

upon too heavily, a user should not always have to manually scrounge around the site to 

find what they need.(U.S. Department of Health and Human Services, 2006) 

This list is also located in Appendix C. 

Heuristic Evaluation 

In order to minimize bias in usability testing, two sites were chosen from an industry that is 

unlikely to be frequently visited by the average Bryant University student.  Travelocity.com and 

Expedia.com are known travel industry websites used to locate and book flights, hotels, and 

other related travel necessities.  The travel industry was chosen because while it is likely that 
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many of the test subjects will have heard about or infrequently used these sites, they will not be 

experts. 

 

A heuristic evaluation was then used to judge the compliance of a site to the 6 guidelines in 

question.  All the pushbuttons were located and then analyzed for their clarity.  It was noted that 

both sites adequately located the pushbutton next to the form it was submitting and was labeled 

in a manner that clearly denoted its action.  Both sites were similarly structured and executed and 

displayed flight searches in a comparable manner, with minor differences.In the future, it would 

also be useful to choose two sites that fall on opposite ends of the usability spectrum.  If a user is 

able to more easily navigate through a site that follows the heuristics instead of one that does not, 

it will provide credence the the HHS’s standards.     

 

Appendix D includes the raw results of the heuristic evaluation. 

Usability Testing 

Usability testing involves requesting users to perform specifics tasks on the located websites.  

Prior to the session, I created a document outlining each action the user is meant to take.  Some 

tasks were purposefully vague, forcing the user to interact with the site and locate the necessary 

page or information themselves.  During these sessions, I targeted the user’s ability to complete 

the task, the length of time it took them to do so, and their level of frustration in performing the 

task.  I performed an exit interview to acquire any information that could not be gathered by 

observing the user performing the task.  I asked their opinion of the task, their perception of how 

easy or difficult it was to complete, and if they believed inability or difficulty completing the 

task would force visitors away from the site.Thisoutline is included in Appendix E. 

 

The results from this study will be aggregated in order to locate trends among the data.  These 

trends will be analyzed to draw conclusions regarding whether or not the guidelines are truly 

important aspects of web usability.  In addition, if any interesting questions are raised or the data 

is inconclusive, this will influence the usability survey created as a follow-up tool to the usability 

study. 
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Usability Survey 

The usability survey was built off the results of the usability study.  Questions were created 

targeting specific areas of interest in order to gather information regarding user’s perceptions 

about the guidelines I had chosen to study.  The Survey was built using SNAP Surveys, a tool 

provided by the Office of Planning and Institutional Research at Bryant University.  The survey 

was hosted online and responses were gathered and imported into the software.  Responses were 

then aggregated and analyzed to determine majority opinion.  The survey incorporated multiple 

choice, likert scales, and free-response questions.  The format was meant to simulate web 

browsing by including full screenshots of the page in question; this was done to encourage 

candid responses from the respondent as face to face follow-up is not an available option with 

surveys.  The survey is included in Appendix F. 

RESULTS 

Usability Study 

Respondent Demographics 
There were a total of 15 participants in the study, with the following demographics: 

- 8 Female / 7 Male 

- 7 Freshmen / 6 Sophomore / 2 Junior 

- 13 New England / 2 International / 1 NJ 

- 11 Business / 3 Liberal Arts / 1 Undeclared Major 

The results were used to influence the creation of the usability survey by first gathering a 

preliminary understanding of how people view web usability or understand usability issues.  

Therefore, the results are anecdotal in nature and specific trends will be discussed. 

 

Three out of the ten students asked to identify a page title were able to correctly provide the title.  

They were shown the Membership page at Travelocity.com, which displays login information or 

the opportunity to sign up for an account.  The actual page title is “Travelocity: Membership” but 

many of the participants identified the page as the Login page.  When asked to how they knew 

the page was a login page, one participant responded, “The words and page layout gave it away.”  
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Other respondents pointed out the username and password fields, as well as the page header that 

read “Login.” 

 

Participants were asked if they wanted to see related information when performing their 

searches.  Twelve of the fifteen respondents responded that they would not want to see any 

information except what they searched for.  One participant believed it would add “too much 

clutter,” while another stated, “If I wanted to see both, I would search for both.”  One respondent 

did say that seeing related information (both flight and hotel information after searching for a 

flight), would be “more convenient.” 

 

The usability study participants were not guided through the navigation of the website.  During 

the exit interview, they were asked how simple or difficult it was to find their way around 

Travelocity.  All respondents stated that the site was easy to navigate; four respondents 

specifically mentioned the tab structure Travelocity uses for navigation while three also 

explicitly stated it was “very straightforward.” 

 

After completing the usability worksheet, respondents were asked to identify a pushbutton on the 

current page they were viewing.  Only one of the respondents could do so.  Once they were 

provided with an example, participants were also asked if they could remember the text on the 

pushbutton following the search form on Travelocity’s home page.  Nine out of fourteen 

participants could not provide adequate text, but suggested similar wording, such as “Search” or 

“Go.” 

 

One of the tasks on the worksheet asked the participants to locate Travelocity’s Return Policy.  

There actually is no page explicitly titled Return Policy on Travelocity.com; it was my goal to 

see how they would search for hard to find information.  This task was produced in response to 

the guideline that stated each page on a website should provide a search box.  Five of the 

fourteen respondents first went to the Customer Service or Help page and then used the search 

box provided there.  Seven of the respondent’s first actions were to use the “Search Travelocity” 



The Effect of Web Usability on Users’ Web Experience 
Senior Capstone Project for Molly Herring 

search box located on each page of the website.  Two users also first thought to check the links in 

the footer of the page before they used the search box. 

Usability Survey 

Respondent Demographics 
There were a total of 52 respondents for the survey, with the following demographics: 

- 26 Female / 26 Male 

- 10 Freshmen / 16 Sophomores / 3 Juniors / 13 Seniors / 10 MBA 

 

29, 56%
13, 25%

10, 19%

RESPONDENTS BY MAJOR

Business

Liberal Arts

MBA 8, 16%

16, 33%

25, 51%

INTERNET BROWSER

Internet Explorer

Firefox

Chrome

I included the question about what browser the student’s use in order to determine, for future 

research, the appropriate browser to use for screenshots in order to reduce any potential 

familiarity bias.  As of February 2012, Firefox and Chrome were competing for the majority of 

web users: Firefox had 36.6% of users while Chrome had 36.3% (W3Schools, 2012).  I would 

recommend that future research using the same body of respondents use Google Chrome for 

screenshots. 
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Chart 1: Printer Version
Question 1: Which version would you prefer? 

I began with questions targeting the printer friendly 

guideline I had chosen to study.  The respondents 

were provided with screenshots of two different 

printed versions of the same article.  The first version 

was created using File > Print and any default printer 
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settings in the dialog box.  The second version was created using the printer-friendly icon located 

on the page. 
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Question 2: When you print a webpage, what do 

you usually do? 
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Chart 2: Print Method

I followed the previous question by asking what the 

respondent typically did to print a page.  I provided 

3 options (Ctrl+P, File>Print, Look for “Printer 

Friendly” Icon) and then provided them with an 

‘Other’ option.  51.9% of respondents stated they 

used File > Print.  The single ‘Other’ response 

clarified, “Copy and paste article into Word.” 

 

Question 3: In the screenshot below, what is the page title? 

I then began focusing on the descriptive page title guideline I had chosen to research.  I provided 

respondents with a screenshot from Reuters.com and asked them to provide the page title.  In this 

example, the page title did not happen to also be within the content of the webpage.  36.5% 

respondents correctly answered, “Business &Financal News, Breaking US & International 

News” for the page title.  Typical incorrect responses included “Reuters” or “Euro zone 

unemployment…” 

 

Question 4: In the screenshot below, what is the page title? 

I asked the same question again,but provided a different screenshot.  This time, similar text 

existed in the content of the page (Politics News) that was also in the page title (Politics & 

Political News).  32.7% of the respondents provided the correct page title; 5 respondents who 

correctly answered the previous question answered this question incorrectly.  Three respondents 

who answered the previous question incorrectly answered this question correctly.A potential 

assumption regarding this information is that getting the page title correct was a “lucky guess” 

and perhaps the respondent did not truly know where to look for the actual page title. 
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Question 5:Suppose you’ve finished reading an article.  How might you find related 

articles? 

I shifted my focus to the guideline regarding linking to related content on the webpage.  65.4% 

of the respondents specifically mentioned looking at the Related Topics or Related News portion 

of the webpage to find related content.  19.2% suggested searching Google or another search 

engine with keywords from the topic or the article name to find additional resources.  17.3% 

mentioned looking for links around the article that led to similar topics, but didn’t specifically 

mention the sidebar seen within the screenshot. 
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Chart 3: Related Information 
FrequencyQuestion 6: When performing a search, how 

often do you look for related information? 

Results: 

- Very often (7.8%) 

- Often (40.4%) 

- Sometimes (44.2%) 

- Rarely (7.8%) 

- Never (0%) 
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Chart 4: Related Information 
Sidebars Question 7: Do you find seeing “related 

information” sidebars on websites helpful? 

Results: 

- Very helpful (17.3%) 

- Somewhat helpful (65.4%) 

- Neutral (15.4%) 

- Somewhat unhelpful (1.9%) 

- Not helpful (0%) 
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Question 8: Please define what a ‘pushbutton’ is. 

The next set of questions focused on the pushbutton guideline that stated pushbutton text should 

be clearly labeled.  A correct answer is defined as any response that described a button that 

“links somewhere,”“is pushable,” etc.  The majority of incorrect responses consisted of some 

variation of “I don’t know.” 

 

Question 9: Please identify a pushbutton 

I provided the respondents with a screenshot of the Google splash page, which consists of the 

Google logo, search box, and two pushbuttons – “Google Search” and “I’m feeling lucky.”  I 

asked the respondents to identify a pushbutton on that page.  Approximately 81% correctly 

identified a pushbutton; this is interesting given that this percentage is greater than the 

percentage of respondents able to define ‘pushbutton.’The majority of incorrect responses were 

“I don’t know,” although one respondent responded, “the Google logo.” 
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Q8: Please define 
what a 'pushbutton' 
is.

Q9: Please identify a 
pushbutton on the 
screenshot

(65.4%)

(80.8%)

(34.6%) 

(19.2%) 

 
Question 10: How confident are you in your selection of the previous question? 

The results of the usability study indicated that not many people knew what the term 

“pushbutton” meant, so I wanted to determine the confidence level of their selection in the 

previous question.  The average confidence level was 2.56.   

- 16 - 
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Very confident  Confident  Neutral  Unconfident 
Very 

unconfident 

1, 1.9%  10, 19.2%  17, 32.7%  13, 35%  11, 21.2% 

Table 1: Responses to Question 10 

I then looked at only those respondents that correctly identified a pushbutton.  The average 

confidence level was only slightly higher at 2.64 and it is interesting to note that the respondent 

who was very confident in his selection was apparently incorrect.  Looking at his response 

(“??”), it may be he was confident in his lack of knowledge rather than confident his response 

was correct. 

Very confident  Confident  Neutral  Unconfident 
Very 

unconfident 

0, 0%  9, 17.3%  15, 28.8%  12, 23.1%  6, 11.5% 

Table 2: Responses to Question 10 for those who responded correctly to Question 9 

Question 11: What would you expect the pushbutton below to say? 

The respondents were asked to “fill in the blank” for a pushbutton on a Travelocity form.I did 

not edit the form in any way except to blank out the text that was already on the pushbutton.  

Results: 

‐ 31 (59.6%) responded generic “Search/Submit/Go” 

‐ 12 (23.1%) specifically mentioned flights 

‐ 6 (11.5%) included terms such as “trip,” “vacation,” or “adventure” 

Despite respondent’s low level of confidence for the previous questions, 71.1% (56.6% + 11.5%) 

of the respondents provided an adequate response for this question.  “Adequate” is defined as 

any response that suits the purpose of the button.  In this case, “Search flights” would not be 

appropriate because the same form could be used to search for hotels only.  Therefore, 

respondents generally seemed able to provide text for a pushbutton even if they weren’t sure of 

what a pushbutton was. 
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Chart 6: NavigationQuestion 12: Which method of navigation do 

you prefer? 

The next two questions focused on the 

guideline stating users should be able to know 

where they are in the hierarchy of the website.  

I provided three common navigation options 

and examples to the respondents: tab structure, 

text navigation, and breadcrumb navigation.  

76.9% of respondents indicated that they 

preferredusing a tab structure to navigate 

around a site. 

 

Question 13: How important is it to you that you are able to retrace your steps? 
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Chart 7: Ability to Retrace Steps

(9.6%)
(1.9%)

(46.2%) 
(42.3%)

 

ANALYSIS OF RESULTS 

Guideline: Develop pages that will print properly 

While 90.4% of the respondents preferred the printer friendly version, only 28.8% of respondents 

specifically look for a printer friendly icon.  What can a company do to make sure their website 

satisfies the desires of their users?  One easy way is to create a specific style sheet for print 

media.  When the page first loads, the browser will render the page according to a specific style 

- 18 - 
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sheet.  However, when the page is printed, the page will be restyled according to the printer 

specific style sheet.  This is one aspect of web usability that would be easy to implement and will 

also satisfy the needs of the user.  I believe that the data conclusively states that this guideline is 

important to web usability. 

 

Guideline: Provide descriptive page titles 

Only 36.5% of respondents correctly identified a page title,but I believe this may be the result of 

unclear terminology.  Many respondents provided the content header rather than the page title 

which may mean they didn’t understand what they were supposed to be looking for.  As 

described by the HHS, providing a descriptive page title is used by search engines to display in 

search results.  In that context, when this page title is displayed in a series of search results, it is 

more obviously a title describing the page.  I would suggest further research into this guideline to 

determine if descriptive page titles truly are a web usability issue, or a search engine 

optimization factor.  The results do not conclusively state whether or not this guideline is 

important to web usability. 

 

Guideline: Provide feedback on user’s location 

88.5% stated that being able to retrace their steps to the current page was “very / somewhat 

important.”  Thus, it can be said that the navigation method is very important because it has the 

ability to tell the user exactly where they are.  79.6% respondents stated they preferred the tab 

structure.  Why is this?  Further research could elucidate why they chose that option, but here are 

some potential reasons: tabs are graphical so one does not need to read the text on each tab to 

know it is a method of navigation and not part of the body of the page.  Tab structure is also 

relatively common and in many ways has become a website norm.  Users expect to see a tab 

structure and already know how they work.  If I were to redesign the survey, I would ask a 

follow-up question about why tab structure was preferred and to distinguish between various 

methods of tab structure implementation.  I believe the data conclusively supports the decision to 

include this guideline as an important web usability factor. 
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Guideline: Link to related content 

The HHS stated that this guideline was rated 4/5 on the Relative Importance scale.  However, the 

respondents to my usability study indicated that they did not want to see related information 

when performing their flight search.  In contrast, 48.1% of survey respondents stated they often 

or very often view related information and 82.7% found it to be very helpful.  I believe the 

contradiction between results in due to the industry being studied in each usability method.  

When visiting Travelocity.com, a user has the option to narrow their search from the beginning 

by choosing “flight,” “hotel,” or “flight and hotel.”  If theuser chooses flight only, they would 

likely not want to then see information about a hotel.  However, it is different when searching for 

an article.  There is an abundance of information available online about anyspecific topic, but a 

user can only read an article at a time.  Onemay want to expand their search and find additional 

articles after reading the first.  Based on the results, I suggest that HHS should clarify that there 

may be differences among industries for how and what related content to link to. 

 

Guideline: Provide a search option on each page 

The usability study clearly indicated that having a search option on each page was expected 

when searching for information on a website.  In addition, 19.2% of the respondents did 

specifically mention searching (either using Google or the site’s search box) to find additional 

information.  I believe the data conclusively supports the inclusion of a search box on each page 

of a website. 

 

Guideline: Label pushbuttons clearly 

Only 17.3% of those who were able to identify a pushbutton were confident in their choice.  

However, 71.2% of respondents provided adequate examples for what text could be placed on 

the button.  Therefore, whether or not the respondent was aware of it, they understood the use of 

the pushbutton and how they are typically used across the internet.  It may have simply been that 

“pushbutton” was the agreed upon term used by the HHS in their publication for consistency, 

while the average user would not use the same name while discussing this web element.  I 

suggest that future research add an additional question displaying a pushbutton and asking the 

respondent to provide a name for that element.  I believe the results imply that labeling 
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pushbuttons clearly is important given that users are subconsciously aware of the text, but I 

suggest further research is needed to find conclusive data. 

CONCLUSION 
Unfortunately, I was never able to get in touch with a representative from HHS to discuss their 

research or the potential impact of my research on their project.  However, I believe that this 

research does give further insight into their guidelines that, in some cases, provides evidence 

supporting their inclusion in the publication.   

 

If I were to perform this research again, there are changes I would make to the methodology.  I 

outline them here to provide future researchers suggestions for their own work in this field.  

Administering the survey prior to the usability study would have aided in developing follow-up 

questions for the study.  A survey provides a general opinion and I would have been able to 

delve deeper during the study by asking targeted follow-up questions based on the respondent’s 

specific actions.  Furthermore, I believe that the tools used in this study could be further 

developed to remove any of the terminology issues (page title, pushbutton) discussed previously.  

These tools could be refined and administered again to a different population of participants.  

Finally, the larger the sample size, the easier it is to state with confidence that results will remain 

valid for the general population. 

 

I also believe studying a pool of participants with a wider range of ages would be very 

interesting.  The population used for this study is considered “tech-savvy” and are generally 

expected to know more than an elder population.  Is this true?  Should specific web usability 

guidelines target one specific audience over another, or do they apply cross generationally?   
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Appendix A – HHS Strength of Evidence Scale 
 

 
 

(U.S. Department of Health and Human Services, 2006, p. xxii)
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Appendix B – Preliminary List of Guidelines 
 

# Title Relative Importance Strength of Evidence 
1:5 Set and State Goals  4 2 

2:12 Develop Pages that Will Print Properly  4 2 
3:1 Comply with Section 508  5 2 

3:2 Design Forms for Users Using Assistive 
Technologies  5 2 

3:4 Enable Users to Skip Repetitive 
Navigation Links  4 2 

3:5 Provide Text Equivalents for Non-Text 
Elements  4 2 

3:6 Test Plug-Ins and Applets for 
Accessibility  4 2 

4:1 Design for Common Browsers  4 2 
4:2 Account for Browser Differences  4 2 

4:3 Design for Population Operating 
Systems  4 2 

4:4 Design for User’s Typical Connection 
Speed  4 2 

5:2 Show All Major Options on the 
Homepages  5 2 

7:1 Provide Navigational Options  4 2 
7:4 Provide Feedback on User’s Location  4 2 
9:2 Provide Descriptive Page Titles  4 2 

10:2 Link to Related Content  4 2 
10:4 Avoid Misleading Cues to Click  4 2 
10:7 Designate Used Links  4 2 
11:2 Format Common Items Consistently  4 2 
13:2 Label Pushbuttons Clearly  5 2 

13:4 Do Not Make User-Entered Codes Case 
Sensitive  4 2 

15:4 Define Acronyms and Abbreviations  4 2 
15:5 Use Abbreviations Sparingly  4 2 

16:3 Ensure that Necessary Information is 
Displayed  5 2 

17:3 Make Upper- and Lowercase Search 
Terms Equivalent  4 2 

17:4 Provide a Search Option on Each Page  4 2 
 

Appendix C – Chosen Guidelines 
 

# Title Relative Importance Strength of Evidence 
2:12 Develop Pages that Will Print Properly  4 2 
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7:4 Provide Feedback on User’s Location  4 2 
9:2 Provide Descriptive Page Titles  4 2 

10:2 Link to Related Content  4 2 
13:2 Label Pushbuttons Clearly  5 2 
17:4 Provide a Search Option on Each Page  4 2 
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Appendix D – Heuristic Evaluation 
 
13:2 – Label Pushbuttons Clearly 
 
Travelocity 

‐ Homepage 
o ‘Search now’ below entering all of the flight data 
o ‘Go’ by the search bar, upper right hand corner 
o ‘Go’ below flight search, for Travel Deals 
o ‘Go’ below Travel Deals, for signing up for Deal Alerts 

‐ ‘View Flights’ after entering flight information 
‐ Flight results 

o ‘Go’ by the search bar, upper right hand corner 
o ‘Search’ by search more airlines option above flight list 
o ‘Select’ by every possible flight option 

‐ After selecting flight 
o ‘Log In and Continue’ after displaying all flight info 
o ‘Continue’ after displaying all flight info 

My opinion: all are clearly labeled because they are placed adjacent to where the information is 
taken for the button and it is evident what pushing the button will do 
 
Expedia 

‐ Homepage 
o ‘Search for Flights’ below entering all of the flight data 
o ‘Search for Flights+Hotel’ below entering all of the flight data 
o ‘Sign Up’ by getting deals sent to inbox box 

‐ Flight results 
o ‘Search’ in New Flight Search box 
o ‘Select’ by every possible flight option 
o ‘Go’ by the search bar, upper right hand corner 

‐ After selecting a flight 
o ‘See more hotels’ near top, where there are hotel choices given 
o ‘Log In and Continue’ after displaying all flight info 
o ‘Continue’ after displaying all flight info 

My opinion: all the buttons are label appropriately and it is evident what pushing the button will 
do.  In comparison, Expedia uses ‘Go’ less and instead more exactly states when the button does. 
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7:4 Provide Feedback on User’s Location 
 
Travelocity 
Navigation tabs at the top of the screen display all the possible locations.  The area you are 
currently visiting is a different color (silver, versus navy blue).  On the homepage, the Home tab 
is activated and when you search for a flight, the Flight tab changes to silver while the Home tab 
returns to navy blue.  URL is also helpful: if you click directly on the Flight tab, the URL reads 
www.travelocity.com/Flights.  After submitting flight info, the path is 
www.travelocity.com/Flights/InitialSearch.do which does accurately describe the current 
position.  However, continuing the search does create more indistinguishable URLs. 
 
Expedia 
Navigation tabs at the top of the screen display all the possible locations.  The area you are 
currently visiting is a different color (white, versus yellow).  On the homepage, the Home tab is 
activated and when you search for a flight, the Flight tab changes to white while the Home tab 
returns to yellow.  URLs make sense if you look closely (http://www.expedia.com/Flights-
Search?trip=roundtrip...) but are not always helpful at first glance. 
 
17:4 Provide a Search Option on Each Page 
 
Travelocity 
There looks to be a search box on the homepage, located in the upper right hand corner.  
However, there is not text distinguishing what it is.  On all other pages, the search box is labeled 
and sits below the navigation, on the right. 
 
Expedia 
Persistent search box in upper right hand corner. 
 
10:2 Link to Related Content 
 
Travelocity 
On the main page, below the Search for Travel area, there are links to common destinations to 
make searching for flights and deals easier.  Once you’ve search for a flight, only flight content 
is displayed but there is the option for changing your search.   
 
Expedia 
On the main page, below the Search for Travel area, there are links to common destinations to 
make searching for flights and deals easier.  Once you’ve search for a flight, only flight content 
is displayed but there is the option for changing your search.  Once you’ve selected the flight, 
they provide hotel options at the top of the screen. 
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9:2 Provide Descriptive Page Titles 
As in, the titles on the browser title bar.  Could also make the title of the page. 
 
Travelocity 
On main pages, prior to search, the title reflects where you are.  When searching for a flight, it 
tells you on which portion of the search you are (i.e., Outbound, Inbound, Review Results). 
 
Expedia 
On main pages, prior to search, the title reflects where you are.  When searching for a flight, it 
personalizes the title by including the airports you are travelling to and from. 
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Appendix E – Usability Session Outline 
 
About You 
Gender: 
Major: 
Age: 
Graduation Year: 
Home state/country: 
How often do you use sites similar to Travelocity, Expedia, Priceline, etc? 
Have you ever participated in usability testing before? 
What browser do you commonly use?  
 
Scenario 
You are a recent Bryant University graduate who has accepted employment in Durham, NC.  
You need to fly home on September 14th to attend a sibling’s wedding.  You will be returning 
September 16th.  Find a roundtrip flight from Durham, NC to Bar Harbor, ME for these dates.  
Find the cheapest flight. 
Also, complete these tasks: 

‐ Choose an alternative airport near Bar Harbor, ME (you do not have to find the cheapest 
flight) 

‐ Locate a hotel in Bar Harbor, ME (you do not have to find the cheapest price) 
‐ Locate the Return Policy, show me, then return to the homepage 

Complete each task in a separate tab.  Please only use Travelocity.com. 
 
Questions After Testing 
  

1. What did you find difficult, or what did you struggle with, if anything? 
2. Bring them to the login page.  

What page are you currently on?  How did you know, what clued you in? 
3. What is the page title of the page you are on? 
4. How easy did you find the site to navigate?  What, if anything, made navigation difficult? 
5. What is a pushbutton?   

a. Answer correct: Can you remember using one?  Which one? 
b. Answer incorrect, show them and then ask: What text was on the pushbutton 

when you search for a flight?   
i. If they don’t know: What would you expect it to say? 

6. If you are searching for a flight, do you want to see hotel information on the same page? 
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Appendix F – Usability Survey  
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